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Intended Use
4DM Personal’s Patient Browser is the front-end to 4DM Personal, which 
is used to load patient data into 4DM, and it provides an intuitive file 
management interface for data access and management. Users can receive, 
export, and query/retrieve DICOM part 10 image files through DICOM 
connectivity to network connected workstations. The patient browser 
provides DICOM file import and export capability to local and network 
directories. The patient browser permits the user to filter, edit, and select 
the data to pass to an application (e.g. 4DM).

Description
4DM Personal’s Patient Browser is a comprehensive data access, transfer and file management system 
for medical imaging data.  Its simple and intuitive interface provides an environment where users can 
perform a variety of image file management operations such as store, import, receive, and transfer files 
between local, shared, and DICOM nodes and perform DICOM Query/Retrieve operations.

Finally, the patient browser provides a gateway to 4DM — an advanced visualization, quantification, and 
reporting software solution by selecting 4DM from the patient browser’s application panel.

You can use the patient browser to do the following:

	▪ Receive and store DICOM image files sent by remote DICOM nodes to a local or network 
connected database or directory.

	▪ Receive Pegasys file formatted images stored to an SCP directory and convert them to an INVIA 
native DICOM image format.

	▪ Receive ECAT file formatted images stored to an SCP directory and convert them to an INVIA 
native DICOM image format.

	▪ Automatically import DICOM image files stored within a defined directory.

	▪ Query/retrieve a list of DICOM image files from remote DICOM nodes to a local or network 
connected database, or a directory.

	▪ Export DICOM image files to local or networked databases and/or directories.

	▪ Export DICOM image files to a remote DICOM node supporting DICOM store.

	▪ Export DICOM image files to external media (CD, DVD, and USB drive).

	▪ Manage multiple databases and/or directories to organize patient data for review.

	▪ Set a search filter for a database or directory to display data based on Patient, Study, and Series 
information in the DICOM file.

	▪ Edit DICOM image files to correct user input errors.

	▪ Access 4DM Reporting to edit an existing report.

	▪ Merge two patients into one.
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User’s Guide Conventions
Throughout this guide, INVIA will rely on consistent use of terminology and symbols to best communicate 
with you, the end user. Below is a summary of these conventions:

	▪ Blue, underlined text represents links to help you quickly navigate within this document or 
launch online content (Internet access required).

	▪ Helpful hints, warnings, and additional information, which appear in the left margin for quick 
and easy reference, are identified by various symbols: 

 Note ! Warning  Tip  Right Click 
Option

Common Abbreviations
The User’s Guide and user interface will rely on the following abbreviations:

Abbreviation Description
AE Title Application Entity Title identifies the DICOM nodes communicating between 

each other.
DICOM Digital Imaging and Communications in Medicine (DICOM) is a standard for 

handling, storing, printing, and transmitting information in medical imaging.
IP Internet Protocol is a unique identification number, such as 127.0.0.1, for 

devices (computers, printers) within a network.
SCP Service Class Provider
SCU Service Class User

System Requirements

Supported 
Operating Systems:

Windows 7 (64 bit)1

Windows 8 (64 bit)1

Windows 10 (64 bit)
Windows 11 (64 bit)

Windows Server 2008 R21

Windows Server 2012 R21

Windows Server 2016
Windows Server 2019
Windows Server 2022

Processor:
Speed: 2.0 GHz or greater
Cores: 4 (minimum), 8 (recommended)

Memory:
8 GB (minimum)
16 GB or more (recommended)

Disk Storage:
512GB or larger NVME hard drive (recommended)
NOTE: 2GB is required to install application.

Video Card: 
256 MB of on board Video Memory (minimum), 1 GB (recommended).
3D graphic card supporting OpenGL 3.0 (minimum) or greater (4.1 
recommended)

Monitor: Up to four HD (1920x1080) monitor(s)

   1 These operating systems are not recommended as they are at or nearing end of life.


More detailed 
instructions for product 
installation can be found 
on the Training and 
Support pages at  
www.inviasolutions.com

http://www.inviasolutions.com
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Accessing 4DM Personal’s Patient Browser
1.	 Close any previous versions of the patient browser and 4DM that are open.

2.	 Insert 4DM Installation media into the computer or server.

3.	 If the media does not autorun, open Install_4DM. 

4.	 Click on Install 4DM.

5.	 Follow the on-screen installation instructions.

6.	 To launch the patient browser, select 4DM from the INVIA tab in your program list in the 
Start Menu.

Licensing
In order to run 4DM Personal, you must have a valid license key. The application supports both fixed 
and floating licenses. To open the Licensing window, select 4DM Licensing from the INVIA tab in your 
program list in the Start Menu. Users have the option to select the site-specific license model type. The 
fields within the Licensing window will change based upon selection.

Fixed License Model (Figure 1.1)

1.	 Hardware ID: This is a unique identifier 
specific to the workstation to which 4DM 
is licensed. 

2.	 File Location: When licensing a fixed 
installation, the user can navigate to the 
directory folder where the 4DM fixed 
license key file is located using the folder 
icon. Once the Check Status icon is 
selected, 4DM will automatically copy 
the license file to the 4DM application 
directory and display the file path.

3.	 Status:  Displays any messages regarding 
the validation of the license key file.

4.	 Available Features: Lists the features 
defined by the license key.

Floating License Model (Figure 1.2)

1.	 Users can choose between the IP 
address and the Hostname to connect 
to the server/workstation where the 4DM 
license manager is installed.

1.	 IP Address/Hostname and Port: Users 
enter the IP Address or Hostname for 
the license manager. Select the Check 
Status icon to verify the connection to 
the license manager.

Figure 1.1: The Licensing window - Fixed License



Left-click About from 
the Help menu to review 
the patient browser’s 
product information, a 
summary of licensing 
information, and to 
access this User’s Guide.


The Licensing window 
can also be accessed 
from the Windows Start 
Menu. Select INVIA and 
then INVIA Licensing.







Figure 1.2: The Licensing window - Floating License






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2.	 Server Information: Displays the active license manager address or hostname, the total 
number of licenses on the license manager, and the number of licenses in use.	

3.	 Status: Displays any messages regarding the validation of the license key file.

4.	 Available Features: Lists the features defined by the license key.

Floating License with Backup Model (Figure 1.3)

1.	 IP Protocol: Users can choose between 
the IP address and the Hostname to 
connect to the server/workstation where 
the 4DM license manager is installed. 

1.	 Primary IP Address/Hostname and 
Port: Users enter the IP Address or 
Hostname for the license manager. 
Select the Check Status icon to verify 
the connection to the license manager.

2.	 Backup Server IP Address/Hostname 
and Port: User enters the IP Address 
or Hostname and Port number for the 
license manager that is designated as the 
backup server. Select the Check Status 
icon to verify connection to the backup 
license manager.

3.	 Server Information: Displays the active license manager address or hostname, the total 
number of licenses on the license manager, and the number of licenses in use

4.	 Status: Displays any messages regarding the validation of the license key file.

5.	 Available Features: Lists the features defined by the license key.

Figure 1.3: The Licensing window - Floating 
License with Backup


















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This chapter guides users through the basic features and functionality of 4DM Personal’s Patient Browser 
while accessing patient files from local and shared directories.

Screen Overview
First, the user should become familiar with the application’s user interface (Figure 2.1 ). The menu bar at 
the top of the interface includes the File, Tools, and Help menus. The interface is designed to flow from 
left-to-right, with three areas: Sources, Search/Patient List, and Applications/Destinations.

	▪ Sources – The left side of the patient browser interface provides a list of data sources. 
Navigate local or shared directories within the Local tab and DICOM-connected 
workstations within the Remote tab to access patient datasets. Add local and DICOM 
folders and databases to the Sources panel for easy access. 

	▪ Search/Patient List – The center area of the patient browser interface allows users to 
filter imaging data by applying search parameters or by prioritizing according to file 
characteristics. Select one or multiple items from the patient list for review or transfer.

	▪ Applications/Destinations – The right side of the patient browser interface applies actions 
to patient files. Launch a patient file in 4DM for review, make edits to DICOM attributes, 
merge patient files, or copy files to local or remote destinations.

Menu Bar

The top menu bar contains File, Tools and Help

File (Figure 2.2)

	▪ Exit: Exits the patient browser

	 Chapter 2	 Navigating the Patient Browser


For help retrieving files 
from remote DICOM 
nodes, go to Chapter 4: 
DICOM Configuration.

Sources Search / Patient List Applications/
Destinations

Figure 2.1: The patient browser screen contains File, Tools, and Help menus, and three areas for user interaction: 
Sources, Search / Patient List, and Applications / Destinations

Figure 2.2: File Menu
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Tools (Figure 2.3)

	▪ Database Manager: Described in Chapter 3

	▪ Local SCP Configuration: Described in Chapter 4

	▪ DICOM Node Configuration: Described in Chapter 4

	▪ Job Queue Manager: Described in Chapter 2

	▪ Preferences: Described in Chapter 5

	▪ Auto Import: Described in Chapter 4

Help options (Figure 2.4)

	▪ About: Provides patient browser product information, 
Language Setting, License Information, Feature List and 
User Guide button 

	▪ Event Viewer: Described in Chapter 4

	▪ 4DM Personal’s Patient Browser Log Viewer: Described in Chapter 4

Sources

The installation process creates a default database on your local drive and loads sample files to a folder on 
your system. These two locations appear as shortcuts in the top left panel of the application (Figure 2.5). 
To browse for local folders with stored DICOM files, simply navigate to the desired location using the 
folder structure directory in the bottom panel of the Local Sources tab (Figure 2.6).

To Select Local Data Sources

	▪ Click on the desired database or directory 
(Figure 2.7). Click the Refresh 
tool (Figure 2.8) in the Patient 
List Panel to display a list of 
patient files.

Figure 2.3: Tools Menu

Figure 2.4: Tools Menu

Figure 2.5: This area displays shortcuts to local folders. Figure 2.6: An example of the folder directory panel.

Figure 2.7: Selected Local Source

Figure 2.8: Patient List Panel



You can load studies 
from multiple sources 
at the same time. The 
patient browser will load 
studies from each source 
that is selected.
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	▪ Local Refresh is done automatically for patient datasets at each level: patient, study, and 
series. The patient browser also auto-refreshes the sources for patient datasets in local mode 
on start-up, on new source selection, when importing, copying, deleting and auto-importing 
4DM result files into database.

To Create a New Source Directory

	▪ Click the Add Local tool (Figure 2.9). Select the 
desired directory and click OK. The new Directory 
will appear in the top Local Sources panel.

To Navigate to a Local Directory (local or mapped drives)

	▪ Navigate to the directory and folder of your choice. Click on the desired destination so it is 
highlighted blue. Click the Refresh tool in the Patient List Panel to display a list of patient 
files.

Search/Patient List

The center of the patient browser interface provides the Search panel and Patient List panel.

Search Panel

The Search panel (Figure 2.10) can be used to search a large database for patient studies. The search 
criteria can be set by Patient Name, Patient ID, Modality, Study Date, Study Description or Series 
Description.

Enter the search qualifiers into the various text fields and then click the Refresh tool in the Patient List 
panel. For examples, see the Tip in the left-column.

The only field that is not text based is the Study Date. This field uses a drop-down menu to set the 
parameters for the search and a pop-up calendar for date selection (Figure 2.11):

	▪ All Dates: Query does not restrict returned files according to dates.

	▪ On: Query will return only studies performed on the specified date.

	▪ Before: Query will return only studies performed before the specified date.

	▪ After: Query will return only studies performed after the specified date.

	▪ Between: Query will return only studies performed between the two specified dates.

	▪ Today: Query will return only studies performed that day.


Search Parameters and 
use of the Wildcard (*): 

	▪ abc – Returns items 
that exactly match 
“abc”

	▪ abc* - Returns all 
items that match the 
characters before the 
asterisk (*); all other 
characters are ignored 
(e.g., abc, abcd, abcde, 
etc).

	▪ *abc – Returns all 
items that match the 
characters after the 
asterisk (*); all other 
characters are ignored 
(e.g., mabc, nabc, 
oabc, etc). 

	▪ *abc* – Returns all 
items that match the 
substring “abc” (e.g., 
abcd, dabc, fabcg, 
etc.)


Search parameters are 
not case sensitive. A 
search for ABC will 
return the same results as 
Abc or abc. 

Figure 2.9: Add Local tool in 
Local Sources Panel

Figure 2.10: The Search panel in its default state

Figure 2.11:  The Study Date area includes a drop-down menu of the various parameters 
for a Study Date search and drop-down menus for day, month, and year.


Save time when loading 
studies — put your most 
frequently used databases 
and folders in the 
Sources menu.
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	▪ Yesterday: Query will return only studies performed on the previous day.

	▪ Last 2 Days: Query will return all studies performed within the past two days.

	▪ Last 7 Days: Query will return all studies performed within the past seven days.

Click the Reset tool  (Figure 2.12) to clear all fields.

Patient List Panel

The Patient List panel displays available files from the selected source(s) or source location(s) 
(Figure 2.13).

This area contains five User Control tools (Figure 2.14) and four File View tools 
(Figure 2.15): 

	▪ Refresh (Double Arrows): Populates or updates the list with files from the 
selected source as filtered according to the search parameters.

	▪ Stop Refresh (Double Arrows with Hand): Cancels the patient list update 
action initiated by the Refresh button.

	▪ Select All (Cursor Arrow with a Check Mark): Selects all of the displayed 
patient files within the patient list.

	▪ Unselect All  (Cursor Arrow with a Minus Sign): Deselects all of the 
displayed patient files within the patient list.

	▪ Delete Selected Dataset(s) (Trash Can): Deletes the selected file(s) from the 
patient list and the source directory. 

	▪ Patient (Person): Displays Patient Name, Patient ID, Most Recent Study 
Date, Number of Studies, and Location within the display list.

	▪ Study (Scanner): Displays Patient Name, Patient ID, Study Date, Study 
Description, Modalities, Number of Series, and Location within the display 
list.

	▪ Series (Single X-Ray): Displays Patient Name, Patient ID, Modality, Series 
Date, Series Description, Number of Images, and Location within the display 
list.

	▪ Instance (Two X-Rays): Displays Patient Name, Patient ID, Modality, 
Instance Date, Instance Description, and Location (only available within local 
mode).

By clicking on the column header in the Patient List panel, the list will sort according 
to that field. The sort order is designated with a small black triangle. A single click will 
organize the information in ascending order, and a second click will reverse the order. 
The columns can be resized by clicking-and-dragging on the column border.



The patient browser will 
conduct the following 
date-based searches 
according to your 
computer’s date setting:

	▪ Today

	▪ Yesterday

	▪ Last 2 Days

	▪ Last 7 Days



When a patient or 
multiple patients are 
selected, the Study, 
Series, and Instance 
Views will apply only to 
those selected patients.  
Return to the Patient 
View to see all available 
patients.


By default, the file list 
will be organized by the 
Patient Name column, 
starting with numerical 
file names and then 
alphabetic file names.



The end user has the 
ability to copy/paste the 
patient list into other 
applications such as 
MSWord, Notepad, Excel 
and other documents 
that support copy/paste 
of text.

Figure 2.13:  Patient List

Figure 2.12:  
Reset tool

Figure 2.14: User 
Control tools

Figure 2.15: File 
View tools
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Applications Panel

The functionality to apply an action to patient files is located in patient browser’s right panel. This panel 
is divided into two areas: the top half is the Applications panel providing button controls for launching 
additional applications; the bottom half is the Destinations panel providing file transfer capabilities.

4DM

To open desired files in 4DM for study review, the user simply needs to select the specific files and then 
click the 4DM button in the Applications panel (see  Figure 2.16). If the user selects a patient that 
does not contain patient images, clicking the 4DM button will open 4DM Reporting.

The user can edit the command line to select a 
specific user workflow to always launch when 
the 4DM application button is selected, e.g. -user 
DrSPECTReview. Right-click on the 4DM application 
button to launch the editor (Figure 2.17). This 
command will launch 4DM with the user configured 
workflow until it is deleted from the Edit Command 
Line Arguments field.

DICOM Editor

The DICOM Editor is accessed through the Application Panel (see  Figure 2.16). The DICOM Editor 
(Figure 2.18) can be used to view patient DICOM information, anonymize patient data, review entire 
DICOM attributes and edit DICOM attributes in the selected file.



Select multiple files 
at once to save time. 
Hold the shift key while 
selecting the first and last 
in consecutive list. Hold 
the control key [Ctrl] 
while selecting multiple 
inconsecutive items.

Figure 2.16: Select files to open in the browser window






Figure 2.17: Right-click to access the 
Command Line Window

!
WARNING
Changing Patient Name, 
Patient ID, Birth Date, 
and Gender can affect 
diagnostic results.
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To load a patient into the editor, 
select it from the Patient List and 
click the DICOM Editor button 
from the Applications panel. 

To Anonymize a Patient Name:

	▪ Select Anonymize Patient 
Name (Figure 2.19)
	– When the button is 
activated it will clear 
the First Name, Middle 
Name, Last Name, Prefix 
and Suffix fields.  The 
Last Name field will display ANON 
followed by the first three characters 
of last name and the first character of 
first name. (i.e., John Doe becomes 
ANONDOEJ)

To Anonymize a Patient ID:

	▪ Select Anonymize Patient ID 
(Figure 2.20)
	– When the button is activated it will 
clear the ID Number field and then 
display ANON followed by first four 
digits of ID Number followed by 
date and time on system at time of 
edit. (i.e., ID NUMBER is 12345678  
edit occurred on 9/8/2009 at 12:12:12pm, becomes ANON123420090809121212)

To Review DICOM file:

	▪ Select Review Entire File 
(Figure 2.21)

	▪ A text file will open in Notepad listing 
the DICOM attributes for the selected 
dataset

	▪ Displayed fields are not editable

To Edit DICOM information in a selected file:

	▪ Choose a field you want to edit 

	– Editable fields are indicated by a text box and allows free text editing

	▪ Click Save to overwrite the original file passed to the editor or Cancel to exit without edits



The check box 
for Anonymize 
Miscellaneous 
Information is 
deselected by default. 
If selected, it will 
anonymize multiple 
miscellaneous DICOM 
fields including: 
Institution Name, 
Institution Address, 
Referring Physician 
Name, Patient Insurance 
Code, and more.

Figure 2.19: DICOM Editor - Anonymize Patient Name

Figure 2.20: DICOM Editor - Anonymize Patient ID

Figure 2.21: DICOM Editor - Review Entire File

Figure 2.18: DICOM Editor
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To Generate New Patient from a selected file:

	▪ Edit the Patient Name or Patient ID 

	– The New Patient button is now available

	▪ Click New Patient to generate the newly defined patient with a copy of all other DICOM 
fields loaded into the editor

Merge Patient

Merging a patient consolidates two patient records into one, in the event that a duplicate has been created 
in error.  

Two example use cases of the Merge Patient functionality in the patient browser are:

1.	 If a user created a preliminary report within 4DM Reporting for “Jon Smith” (incorrect 
spelling) and then later imported a patient named “John Smith” (correct spelling) from the 
worklist and acquired patient images. 

	▪ Two patients would be created since the names do not match. 

	▪ Merging Jon Smith’s preliminary report into John Smith’s image data would create a 
single patient that contains both the patient information as well as the patient images.

2.	 If patient images were acquired under the wrong patient entirely – e.g., the user selected 
“Jane Smith” from the worklist and acquired patient images, when the user should have 
selected “John Smith.” 

	▪ Two patients would be created since the names do not match. 

	▪ Merging Jane Smith’s patient images into John Smith’s patient file would reassign 
the images to the correct patient.

To combine two patients into one, select both patients from the patient list, and click Merge Patient 
(Figure 2.22). In the Merge Patient window, select the Up arrow to merge Patient 2 into Patient 1, or 
select the Down arrow to merge Patient 1 into Patient 2. 

During the merge, any DICOM datasets from the other patient is added to the master patient. Note that 
DICOM datasets are always added to the master patient, never overwritten. 

Figure 2.22: Merge Patient tool


If the patient is located 
in a Database the 
Overwrite option is 
disabled. 
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The patient the user merges into will dictate the Patient Name, Patient ID, Gender, and Date of Birth 
that the patient retains. All other demographics and medical history information that are retained will be 
taken from the more recently saved patient information. 

A pop-up window allows the user to delete or keep the secondary patient. Note that, during the merge, 
the user will not have the option to select which fields to keep or overwrite. 

Destinations Panel (Figure 2.23)

To copy patients to a database:

	▪ Select specific patient files
	▪ Select the target database
	▪ Click the Copy To tool (Figure 2.24)

To copy patients to a DICOM node:

	▪ Select specific patient files
	▪ Select the target DICOM node
	▪ Click once on Copy To tool

To copy patients to a New Directory:

	▪ First, create a new directory
	– Click the Add Local (Figure 2.25) button
	– Select the desired directory
	– Select OK

	▪ The new directory path will appear in the Destinations panel
	– Select specific patient files
	– Select the target directory

	▪ Click once on Copy To tool

Status Bar
The patient browser interface provides a Status Bar along the bottom of the patient browser screen. There 
are five display panels on the Status Bar (Figure 2.26): 

	▪ Job Queue: The number of Active Jobs and Completed Jobs will be displayed in addition 
to Last Job Status. If an error occurs, the Failed status window will be displayed and 
provide the reason of failure.  
	– Left-click on the Job Queue to view the Job Queue Manager.

	▪ Job Queue Manager: Displays Status, Timestamp, Type and Details for both Active Jobs 
and Completed Jobs.
	– Active Jobs: The user can View Job Details, Move Job Up, Move Job Down, Cancel Job 
and Pause/Resume Job in the Job Queue Manager.

Figure 2.24: Copy To tool


Right-click on the status 
bar to display the last 100 
actions in a window.

Figure 2.25: Add Local tool

Figure 2.26: Status Bar

Figure 2.23: Destination Panel
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	– Completed Jobs: The user can View Job Details and Delete/Clear All jobs in the Job Queue 
Manager.

	▪ Action Status: Displays Copying actions. 

	▪ Number of Pending Results: Denotes the number of DICOM result files from Corridor4DM 
pending import into a database.

	▪ Number of Patients: The number displayed depends on the Patient Display List
	– Displays the total number of selected patient files.

	▪ Number of Studies: The number displayed depends on the Patient Display List
	– Displays the total number of selected study files

	▪ Number of Series: The number displayed depends on the Patient Display List
	– Displays the total number of selected series files

	▪ Number of Instances: The number displayed depends on the Patient Display List
	– Displays the total number of selected instance files. (Only available on the Local tab. On the 
Remote Tab, the display panel is always blank.)
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Database Manager
The Database Manager window (Figure 3.1) is accessible from the Tools menu and permits the user to 
add and delete databases as well as manage database files.

These are the Database Manager tools:

	▪ Database Information: (Figure 3.2) Provides details about the 
selected database (Database ID, Database Filename, Database 
Location and Type (local or network). Left-click to access the 
following database tools (Figure 3.3):

	– Test Database Connectivity: Tests the connectivity between 
the patient browser and the selected database. This is useful for 
troubleshooting issues with networked databases. 

	– Database Cleanup Schedule: This tool provides a window where the 
user can define an automatic cleanup schedule to reduce the size of an 
image database.  Within this window, the user can define the time the 
scheduled cleanup will occur and the criteria for which files are to be 
deleted when threshold limits are reached.

	– Rebuild Database Index: Reconciles the number of database entries 
with the number of files.

	– Compact Databases: Reclaims wasted space within the databases and 
improves performance. 

	– Database Auto-Routing Schedule: This tool provides a window 
where the user can specify a DICOM destination where images will be 
automatically transferred.  This is primarily used for pushing results to 
a PACS system.  For each database, the user can specify one or more 
destination DICOM nodes (Auto-Routing Nodes), a start date after 
which all image files will automatically transfer to the destination(s), 
and the schedule time when the automatic transfer will occur. 
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





Figure 3.2: 
Database 

Information Tool



If All Studies Older Than 
a certain number of days 
are selected, comparison 
studies that are older 
than the defined day 
range in the database will 
be deleted during the 
Database Cleanup Time.



Databases have an 
advantage over folders 
when it comes to patient 
file storage. Queries 
return search results in 
less time. Also, users can 
efficiently add and delete 
files.

Figure 3.3: 
Database 

Information Window 
Tools













Figure 3.1: Creating a new data storage location using the Database Manager 
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	▪ Add/Link Database: (Figure 3.4) Creates or links a database and adds it to the Sources and 
Destination panels. 

	▪ Rename Database: (Figure 3.5) Edit the selected database name.

	▪ Unlink Database: (Figure 3.6) Unlink the selected database from the system and remove it 
from the lists in the Sources panel and Destinations panel without deleting all related data 
from the system.

	▪ Delete Database: (Figure 3.7) Deletes the database from the database list in the Sources 
panel, Destinations panel, and all related data from the system. This operation cannot be 
reversed.

	▪ Update Database: (Figure 3.8) Updates the selected database

	▪ Refresh: (Figure 3.9) Updates the current list of the database tables.

Creating a Local Database for Image Storage

Users can build multiple databases to catalog patient 
data for specific uses. As an example, this guide will 
illustrate creating a Training database.

1.	 Open the Database Manager window from 
the Tools menu

2.	 Select Add/Link Database tool

3.	 Create a new File name (see  Figure 3.10)
4.	 File type will remain INVIA Database 

(*.icbd)
5.	 Select Open to complete the task
6.	 The new database name will appear 

automatically in the Database Manager 

Creating a Network Database for Image Storage

Prior to creating a network database, you will need to insure that the directory on the remote computer 
is shared to the network. You also need to insure that the security settings for this directory allows for 
remote users to read and write files to this directory. Once sharing and security are defined on the remote 
computer:

1.	 Open the Database Manager window from the Tools menu
2.	 Select Add/Link Database
3.	 Navigate to the shared directory
4.	 Create a new File name (e.g. Training)
5.	 File type will remain INVIA Database (*.icbd)
6.	 Select Open to complete the task
7.	 The new database name will appear automatically in the Database Manager 



Want to collect 
interesting cases in a 
single database? Create 
a custom database and 
copy patient files using 
the patient browser file 
transfer functionality. 

Figure 3.4: Add/
Link Database 

Tool

Figure 3.5: Rename 
Database Tool

Figure 3.6: Unlink 
Database Tool

Figure 3.7: Delete 
Database Tool

Figure 3.9: Refresh 
Tool

Figure 3.10: Creating a new database in the patient browser



Figure 3.8: 
Update Database 

Tool



4DM Personal’s Patient Browser ▪ User’s Guide	 Chapter 4: DICOM Configuration ▪ 16

Upon installation, 4DM Personal will configure a base Service Class Provider (SCP) using the following 
parameters:

1.	 Station Name (by default, this will be the computer’s name)
2.	 Application Entity (AE) Title (same as Station Name by default)
3.	 Port # (automatically generated with first available port starting with Port 104)
4.	 IP address or addresses
5.	 Data Storage (“Database: Default” is assigned upon installation)

Local SCP Configuration

Base SCP Configuration

Initiating the Base SCP

Once 4DM Personal is installed, users must 
turn on the Base SCP so Corridor Browser 
can “listen” for other DICOM workstations. 

1.	 Launch 4DM Personal
2.	 Select Local SCP Configuration 

from the Tools menu at the top of 
the Corridor Browser interface

3.	 In the Local SCP Configuration 
(Figure 4.1) window, verify that 
the SCP status is on and click OK

All SCPs need the type of file storage defined (e.g., 
database or files). The base SCP will store transferred 

files to the default database created at installation. 

Customizing the Base SCP Configuration

	▪ In the Local SCP Configuration 
window, customize the following 
fields in the Base SCP Configuration panel (Figure 4.2):
	– Station Name
	– AE Title
	– Port 
	– IP

Assigning a Database to 
the Base SCP

	▪ In the Local SCP 
Configuration 
window, select the 
Data Storage drop-
down menu

	 Chapter 4	 DICOM Configuration

Figure 4.1: The Local SCP Configuration window 



SCP vs. SCU
These two terms 
are important for 
understanding the 
communication 
capabilities of DICOM 
compliant workstations.

A Service Class User 
(SCU) is a device that 
requests a DICOM 
Service, typically a client 
requesting information or 
data from an SCP.

A Service Class Provider 
(SCP) is the device that 
provides the service to an 
SCU, e.g. image storage, 
image query with image 
storage. 

The patient browser 
provides connectivity for 
both of these services. 
Databases or folders 
saved in the Sources 
panel act as SCUs while 
databases or folders 
saved in the Destinations 
panel act as SCPs.

Figure 4.2: The SCP Base Configuration area is the top panel 
within the Local SCP Configuration window



When defining a port, 
users should confirm that 
the port is not used by 
another network service. 
Consult your IT manager 
for assistance.



The Station Name will
identify the Corridor
Browser-based SCP
within the network.
This SCP will initially
listen on all available
IP addresses. If no IP
address is available,
None will appear as the
IP address and the SCP
service will remain off
until an IP address is
available or defined.
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	▪ Select Database (Figure 4.3)
	▪ Select the desired database in the second drop-down menu 

	– If the default database is the only available option, you can 
reference Chapter 3 to create a new database

Assigning File Location to the Base SCP

	▪ In the Local SCP Configuration window, select the Data Storage drop down menu in the 
Base SCP Configuration panel (top):

	▪ Select Files
	▪ The following fields are now available for edit:

	– Root Directory (Browse): Main location of the directory
	– 1st Subdirectory: First level of the directory organization
	– 2nd Subdirectory: Second level of the directory organization (Figure 4.4)

Additional Local SCPs

Creating Additional Local SCPs

	▪ In the Local SCP Configuration window, make the following edits in the Additional Local 
SCPs panel (Figure 4.5):
	– Enter a unique AE Title and Port #
	– Set the Data Storage location 
	– Turn SCP Status On
	– Click the Add tool (Figure 4.6)



Any changes to the Base 
SCP and Additional 
Local SCPs will cause it 
to automatically stop and 
restart. This is a “behind 
the scenes” action and 
generally takes less than 
30 seconds. Any changes 
to an SCP should not 
occur during data 
transfers.



When defining a port, 
users should confirm that 
the port is not used by 
another network service. 
Consult your IT manager 
for assistance.



Users can organize files 
within the SCP root 
folder by selecting a first 
and second subdirectory. 
Data can be arranged by:

	▪ Patient Name
	▪ Patient ID
	▪ Modality
	▪ Study Date
	▪ None

Figure 4.3: Database 
selection options

Figure 4.4: Example of the file directory structure

Figure 4.5: The Additional Local SCP area is the bottom panel within 
the Local SCP Configuration window.

 Figure 4.6: 
Add Tool
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Assigning a Database to an Additional SCP

	▪ In the Local SCP Configuration window, make the following edits in the Additional Local 
SCPs panel:
	– For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating 
Additional Local SCP’s section above), then continue to next step

	– For an existing SCP, select the SCP in the list and continue to next step
	▪ Go to the Data Storage drop down menu
	▪ Select Database
	▪ Select desired database in the second drop down menu 

	– If the default database is the only available option, you can reference 
Chapter 3 to create a new database

	▪ For a new SCP, click the Add tool (Figure 4.7) and then click OK
	▪ For an existing SCP, click the Edit tool (Figure 4.8) and then click OK

Assigning File Location to an Additional SCP

	▪ Launch 4DM Personal
	▪ Select Local SCP Configuration from the Tools menu
	▪ In the Local SCP Configuration window, make the following edits in the Additional Local 

SCPs panel (bottom):
	– For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating 
Additional Local SCP’s section above), then continue to next step

	– For an existing SCP, select the SCP in the list and continue to next step
	▪ Go to the Data Storage drop down menu
	▪ Select Files
	▪ A new window will open to set the following fields 
	▪ The following fields are now available for edit:

	– Root Directory (Browse): Main location of the directory
	– 1st Subdirectory: 1st level of the directory organization
	– 2nd Subdirectory: 2nd level of the directory organization (Figure 4.9)

	▪ For a new SCP, click Add Local SCP and then click OK
	▪ For an existing SCP, click Edit Local SCP and then click OK

SCP Services

Change the Base SCP Status 

	▪ Set the SCP Status toggle (On or Off) (Figure 4.10)
	▪ Click OK

 Figure 4.7: 
Add Tool

 Figure 4.8: 
Edit Tool

Figure 4.9: Example of the file directory structure

Figure 4.10: The SCP Status Toggle



When the SCP status 
is turned Off, remote 
DICOM work stations 
will not be able to 
transfer files to Corridor 
Browser.
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Change an Additional SCP Status 

1.	 Select the Additional SCP to be modified
2.	 Set the SCP Status Toggle (On or Off)
3.	 Click the Edit tool
4.	 Click OK

Deleting an SCP

To permanently remove a custom SCP, select it from the Additional Local 
SCP list, click the Delete (Figure 4.11) tool and then click OK to close the 
window.

Register SCP Service

For systems using the Windows Firewall (recommended), this button will register the CorridorSCP 
application with the firewall. By doing so, the patient browser allows outside computers to query and 
store images to the local SCP.

DICOM Nodes

DICOM Node Configuration

Adding a DICOM Workstation to the Sources and/or Destination Lists 

	▪ Select DICOM Node Configuration 
from the Tools menu

	▪ In the DICOM Node Configuration 
window (Figure 4.12), click the New 
tool (Figure 4.13) 

	▪ Enter a unique Name in the DICOM 
Node Settings window (Figure 4.14)

	▪ Enter the AE Title for the DICOM 
workstation to which you want to 
connect

	▪ Confirm that the DICOM Port on the 
remote workstation is 104 (change it if necessary)

	▪ Enter the DICOM workstation’s IP Address

	▪ Select the desired Type for the DICOM Node
	– Query: Adds the new DICOM Node to the 
Sources panel on the Remote tab

	– Store: Adds the new DICOM Node to the 
Destinations panel on the Local and Remote tabs

	▪ Click Test to confirm the DICOM connection is 
successful

	▪ Click OK to close the Test window
	▪ If passed, click OK on the DICOM Node Settings 

and DICOM Node Configuration windows to save 
settings



The Name field identifies 
the remote DICOM 
node within Corridor 
Browser. Use a unique 
name associated with 
that system (e.g. Camera 
Room One).

!

WARNING
Remote DICOM 
workstations will need 
to be configured to 
recognize Corridor 
Browser SCPs. Refer to 
the workstation user’s 
manual or contact a 
service representative for 
assistance.

Information necessary 
to complete this step 
includes AE Title, Port #, 
and IP address for each 
workstation.

For more information 
on remote workstation 
configuration, visit 
www.inviasolutions.com


Users cannot delete the 
Base SCP; it can only be 
deactivated (turned off).

 Figure 4.11: 
Delete Tool

Figure 4.12: DICOM Node Configuration window

Figure 4.13: 
New Tool

Figure 4.14: DICOM Node Settings

http://www.inviasolutions.com
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Editing a Previously Added DICOM Node 

	▪ Click the desired DICOM node from the DICOM Node Configuration window (Figure 4.15)
	▪ Click the Edit tool
	▪ Make the necessary changes on the 

DICOM Node Settings window
	▪ Click the Test tool to confirm the 

DICOM connection is successful
	▪ Click OK to close the Test window
	▪ If passed, click OK on the DICOM 

Node Settings and DICOM Node 
Configuration windows to save 
settings

Deleting a Previously Added DICOM Node

	▪ Select DICOM Node Configuration from the Tools menu
	▪ Click the desired DICOM node

	▪ Click the Delete tool then OK to close the window

Auto Import Configuration
The patient browser will enable the user to import a specific image file type (i.e. DICOM, Pegasys, 
ECAT) from a Windows directory folder automatically into the local DICOM SCP data storage 
location. The files are deleted from the Windows directory folder after the transfer has completed.

How to Configure

1.	 Select Auto Import from the Tools menu found on the top Menu Bar.

2.	 Click Browse to navigate and select the Windows directory folder.

3.	 Select the Data Format for incoming image file types.

	▪ DICOM – If selected, only DICOM files are read and pushed to the SCP.

	▪ Pegasys – This selection will only read and convert Pegasys formatted image files.  
If selected prior to sending to the SCP, the files are converted from Pegasys format to 
INVIA DICOM format.

	▪ ECAT – This selection will only read and convert ECAT 7 formatted image files.  If 
selected prior to sending to the SCP, the files are converted from ECAT format to 
INVIA DICOM format.

4.	 Select the Data Destination then Add.

The user can remove a Windows directory folder from the Auto Import directory list by clicking 
Delete.

Troubleshooting Auto-Import

During the conversion process, a “Pending” folder will be generated within the Auto Import specified 
directory folder as a temporary placeholder for files awaiting conversion.

If the conversion process fails, then a “Failed” folder will be created within the Auto Import specified 

Figure 4.15: Create, edit, delete, and test DICOM Nodes
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directory folder containing the files that failed the conversion process.

 If the user is trying to configure an auto import rule and there are not any options displayed in the data 
destination drop down menu, the user will need to turn “on” the Local Base SCP Configuration. 

Troubleshooting
Within the patient browser’s Help menu, users can review a record of DICOM activity. The following 
logs are available:

	▪ Event Viewer: Records all events and actions for all instances of the patient browser 
that are running. This information is used to track potential errors in the operation of the 
application which is useful for INVIA to troubleshoot problems with the application.

	– Select Event Viewer from the Help menu 
	– Once the Event Viewer is open, select INVIA from the list to view log entries
	– To save the INVIA log to aide in advanced troubleshooting
•	 Right-click on INVIA
•	 Select Save Log File As…

	▪ 4DM Personal’s Log Viewer: Provides a real time display of all actions and events 
executed by the currently active patient browser. When a problem has occurred with the 
application, this tool can help record the specific steps. This tool will be used by INVIA to 
troubleshoot problems with the patient browser.



Only one file type can be 
configured per directory.  

Different image file 
formats need to be sent to 
separate Windows 
directory folders.
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	 Chapter 5	 Data Management

File Management
4DM Personal’s Patient Browser is designed to provide an interface for DICOM file management. This 
section will provide examples of file retrieval and transfer from a variety of sources.

Local to Local

Follow this tutorial to transfer DICOM files from local sources (folders or databases) to local destina-
tions (folders or databases). Refer to Chapter 2 for help creating local sources and destinations.

1.	 Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\Docu-

ments\INVIA\Corridor4DM\SampleData)

2.	 Click the Refresh tool in the Patient List Panel to display a list of patient files

3.	 Select files for transfer

4.	 Click the desired Local Destination so it is selected

5.	 Select the Copy To tool

6.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

Figure 5.1: Local to Local Data Transfers
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Local to DICOM (Remote)

Follow this tutorial to transfer DICOM files from local sources to remote destinations. Refer 
to Chapter 2 for help creating local sources and Chapter 4 for help creating remote DICOM 
workstations.

1.	 Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\
Documents\INVIA\Corridor4DM\SampleData)

2.	 Click the Refresh tool in the Patient List Panel to display a list of patient files

3.	 Select files for transfer

4.	 Click the desired DICOM (Remote) Destination so it is selected

5.	 Select the Copy To tool

6.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

Figure 5.2: Local to DICOM (Remote) Data Transfers
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DICOM (Remote) to Local

Follow this tutorial to transfer DICOM files from remote sources to your PC. Refer to Chapter 4 for 
help creating Remote DICOM sources and destinations and Chapter 4 for help creating additional 
Local sources and destinations.

1.	 Click the Remote tab

2.	 Select the desired DICOM Source (e.g., DICOM: InterestingCases)

3.	 Once the data source is selected, click the Refresh tool in the Patient List Panel to display a 
list of patient files

4.	 Select files for transfer

5.	 Select the DICOM Destination labeled with your AE Title (e.g., DICOM:ReadingRoom). 
This will send the data to the location defined in the Local SCP Configuration

6.	 Select the Copy To tool

7.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete



In order to transfer
data from a remote
workstation to your PC,
you will need to start the
default SCP service.
Refer to Chapter 5 for
step-by-step instructions.


During installation,
the patient browser
names the Base SCP
with the same name
already assigned to your
computer.

Figure 5.3: DICOM (Remote) to Local Data Transfers
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DICOM (Remote) to DICOM (Remote)

Follow this tutorial to transfer DICOM files from remote DICOM sources to another remote 
DICOM destination. Refer to Chapter 4 for help creating remote DICOM sources and workstations.

1.	 Click the Remote tab

2.	 Select the desired DICOM Source (e.g., DICOM: InterestingCases)

3.	 Once the data source is selected, click the Refresh tool in the Patient List Panel to display 
a list of patient files

4.	 Select files for transfer

5.	 Select the DICOM Destination (e.g., DICOM:Clinic)

6.	 Select the Copy To tool

7.	 Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

Preferences
4DM Personal’s Patient Browser provides the ability to Backup, Restore, 
and configure Options within Preferences. To access these settings, click 
Tools and select Preferences (Figure 5.5) to open the patient browser’s 
Preferences window.

Backup

The Backup tab (Figure 5.6) enables the user to define 
a Backup Directory location and specify which options 
to select under Backup Global Settings/Directories and 
the Backup Format when performing patient browser’s 
Preference Backup.  This should be performed after the 
initial setup of the patient browser.

Figure 5.4: DICOM (Remote) to DICOM (Remote) 
Data Transfers
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Figure 5.5: Select Preferences

Figure 5.6: Patient Browser’s Preferences - Backup
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Restore

The Restore tab (Figure 5.7) enables the user to 
specify the directory location of the patient browser’s 
Preference Backup using the Restore Directory.  
Under Restore Global Settings/Directories, the user 
selects from available options contained in the patient 
browser’s  Preference Backup to restore the patient 
browser settings.

Options

The Options tab (Figure 5.8) provides Language 
Settings if the user wants to set a language different 
from the Windows OS, Patient Display Settings if 
the user wants to change the default display level, and 
DICOMDIR support for exporting datasets with a 
DICOMDIR included.
.

Figure 5.7: Patient Browser’s Preferences - Restore

Figure 5.8: Patient Browser’s Preferences - Options
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